HUONG DAN CAI PAT VA SU DUNG PHAN MEM
MELSOFT GX DEVELOPER V8.0

GX Developer la mot phan mém lap trinh kha phd bién véi dong PLC
Mitsubishi , né cung cap day du cac cong cu dé lap trinh mot cach thuan tién , giao
dién don gian d& st dung . Sau day la cach cai dit va cac budc dé co thé 1ap trinh mot
chuong trinh chay mé phong véi PLC.

3.1 Nhirng yéu céau trwéc khi cai dit

Pé cai dat phan mém GX Developer V8.0, can c6 dia cai dat do nha san xuat
cung céap, hoic co thé dowloand truc tiép trén mang théng qua website:
http://plctech.com.vn/phan-mem-lap-trinh-plc-mitsubishi/

Chuong trinh GX Developer da c6 twong d6i lau nén yéu cau ciu hinh cua PC
khong can cao. Hau hét cac may tinh hién nay déu cd thé hd tro dugc nhu Win2000,
WinXP , Win7, hoac Windows Vista .

it Required FC performance
em
CPU Required memory
Windows"™ 85 (Service Pack 1 or higher}) Pentium™ 133MHz or hig|h|3r’i'"1 32MB or mare *
Windows" 98 Pentium™ 133MHz or hig|h|3r’;"'1 32MB or more * °
Windows ™ Millennium Edition Pentium® 150MHz or higher*’d 29MB ar more ¥ °
WindowsMNT™ Workstation 4.0 .
Hrneas e IDI-! Pentium™ 133MHz or hig|h|3r”'1 32MB or more *
BSerice Pack 3 or higher)
Windows™ 2000 Professional Pentium® 133MHz or higher*d &AMB or mare ¥ °
Windows" XP Pentium™ 300MHz or hig|h|3r:Lq 128MB or more *°
Windows Vista™ Pentium™ 1GHz or higher 1GB or more
1GB or more (32-bitWindows™ 7}
Windows™ 7 Pentium™ 1GHz or higher L )
2GB or more ([B4-bitWindows™ T}
1GB or more (32-bitWindows™ 8)
Windows™ 8 Pentium™ 1GHz or higher L )
2GB or more (B4-bitWindows™ B)

#4: Pentium™ 300MHz or higher is recommended when creating label programs.
* 5. B4MB or more is recommended when creating label programs.

Khi cai dat véi GX Developer V8.0, can chl y trudc hét ta phai cai dat moi trudng cho
phan mém , sau d6 méi cai dat GX Developer V8.0 . Ca hai phan mém nay déu nam
trong Forder cai dat .


http://plctech.com.vn/phan-mem-lap-trinh-plc-mitsubishi/

3.2 Cac buéc thuc hién cai dit phan mém .
3.2.1 Cai dit méi trweong lam viéc cho phan mém .

— Pobng tat ca cac ctra s6 1am viéc lai.
— Dua dia cai dit phan mém GX Developer V8.0 vao 6 doc CD-ROM , hoic tai

phan cai dat tir trang website:  http://plctech.com.vn/phan-mem-lap-trinh-plc-
mitsubishi/

1. Vao thu muc chira phan cai dit GX Developer V8.0 .

Chon Folder EnvMel ¢é mé phan cai dat méi truong phan mém.

. » Computer » Software () » GXDeveloper 91v_Upgrade [plctech.comwn] » GXDeveloper 91v_Upgrad

File Edit View Tools Help

Crganize - Include in library - Share with = Mew folder
- Favorites ; DMaviPlus
Bl Desktop , EnvIMEL
4. Downloads . GX_Com
5| Recent Places , Update
& Onelrive || INST32LEX_ ) . .
[ _ISDEL Kich dup vao Folder
_ — EnvMEL dé m& phan
Libraries |% _SETUP.DLL i - _
L cal dat moi truong
_:l Documents E—Wﬂ-
J’. Music g_userl
=| Pictures | |DATATAG
B videos Edatal
B ang
*& Homegroup @ layout
|%| LicCheck.dll
M Computer o
&, Local Disk (C) %] PROCHECK.dII
—a Software (D) || SERIAL SETUP
il CD Drive (E:) GT_Work3 & Setup
[m5]SETUP
€ Network 45| SETUP

|| setup.ins

|| setup.lid


http://plctech.com.vn/phan-mem-lap-trinh-plc-mitsubishi/
http://plctech.com.vn/phan-mem-lap-trinh-plc-mitsubishi/

2. Chon Setup dé cai dat méi trudng 1am viéc cho phan mém .

b Computer b Software(D:) » GXDeveloper 9lv_Upgrade [plctech.com.vn] » GXDe

File Edit View Tools Help

Organize = Include in library Share with « Mew folder
W Faverites || INST32LEX_
Bl Desktop =7 _ISDEL
8 Downloads %) _SETUP.DLL
| Recent Places 3-5}’51
& OneDrive B _userl Kich dip file SETUP
' | DATA.TAG de cai dat moi
=3 Libraries B datal truong cho GX
| B iang Developer

AJ‘I Music @Iayou’t
bl Pictures i os
B videos 7] SETUP
4 | SETUP
o Homegroup || setup.ins
| setup.lid

3. Chon Next

“Welcome to the Environment of MELSOFT Setup program. This
program will install Environment of MELSOFT an pour computer.

It iz strongly recommended that pou exit all Windows programs
befare running thiz Setup program.

Click Cancel to gquit Setup and then cloze any programs you have
running.  Click Mest to continue with the Setup proaram.

wWiaRMIMG: Thiz program iz protected by copynight law and
intermational treaties.

Unautharized reproduction ar distribution of this program, or any
portion of it, may result in severe civil and criminal penalties, and
will be prosecuted to the maximum extent possible under law.

¢ Back Cancel




4. Chon Next

The program inztallz the necessamn spstem files for -
inztaling MELSOFT product into the computer.

The usage of thiz program for purposes other than

ingtalling of MELSOFT product iz prohibited.

Cancel

Setup haz finizhed inztaling Environment of MELSOFT on pour
computer.

Click Finizh to complete Setup.

< Back I Finizh I




3.2.2 Cai @it phan mém GX Developer V8.0.

Sau khi da cai dit xong moéi truong cho phan mém GX Developer V8.0 quay tro
lai Folder cai dit phan mém GX Developer ban dau .

1. Chon file Setup dé bat dau cai dat phan mém GX Developer V8.0

@ . v Computer v Software (0] » GEDeveloper 91v_Upgrade [plctech.coman] » GXDeveloper 91v_Upgrade [plctech.

File Edit View Tools Help

Organize » Include in library = Share with - Mew folder
- Favorites . DMaviPlus
Bl Desktop . EnvMEL
& Downloads , G¥_Com
- Recent Places . Update
/& OneDrive || IMST32LEX_
[ ISDEL
) Libraries |%| _SETUP.DLL
| Documents B sl
J'- Music E_userl
= Pictures || DATATAG
& videos Betal Kich dip vio file
lang SETUP d bat dau
& Homegroup @Iaynut cai dit l)l]ﬁl] mim
% LicCheck.dll
1M Computer i3 os
& Local Disk (C3) @] PROCHECK.dI
-, Software (D) | SERIAL SETUP
o) CD Drive (E) GT_Work3 | Setup
[ SETUP
€ Network 44| SETUP
| |setup.ins

| |setup.lid



2) Chon OK khi hién canh bao dong tat ca cira s6 dang 1am viéc lai .

X Developer Version 8
Installation

There is a possibility for improper installation
! . if you execute without closing all the running applications(Including
resident programs).0k?

3. Chon Next

Wwielzome to the S\wWinDB-GPPW Setup program.  This program
will inztall ShwinD5-GPPW on vour computer.

It iz strongly recommended that pou exit all Windows programs
befare running this Setup program.

Click Cancel to quit Setup and then cloze any programs wou have
munning. Click Mest to continue with the Setup program.

WwARMIMG: Thiz program is protected by copyright law and
international treaties.

Jrnauthorized reproduction or distribution of this program, ar any
portion of it, may rezult in severe civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

Cancel




4. bién théng tin ngudi cai dat ,c6 thé dit tén tuy ¥, sau d6 chon Next dé qua trang ké
chon Back khi muén quay tré lai trang trude dé .

User Information

Type your name below. You must alzo bype the name of the
company you work, for.

M ame: |Kh|:|a Co Khi bay

Cormpary: |Truu:-ng Dai Hoc Su Pham Ky Thuat

Cancel |

5. Chon Yes dé khang dinh lai thong tin dién trudc d6 1a dung , chon No khi muén dién
lai théng tin

Y'ou have provided the following registration information;
M armne:; Khoa Co khi May

Compary: Truong Dai Hoo Su Pharn Ky Thuat

|z thiz registration information comect?




6. Dién ma cai dat chwong trinh do nha cung cap phan mém dua ra , c6 di kém theo dia
Néu tai phan mém cai dat trén Website vé thi dién ma cai dat nhu sau : 352-100201687
,sau do6 chon Next

Tnput ProductC

Fleaze enter the product D of the product.
Pleaze input in zingle byte English characters.

10020 657

7. Chon Next

Pleaze zelect inztall following function.
[ST Language iz a structurizing text language that iz defined by
IECE1131-3 standard)]

[ ST [Structured Text) language programming function




8. Chon Next

Select component of "Only for maonitaring'' G Developer.
If zelect the only far monitoring edition, can not edit program, and
wirite to PLLC.

[ Onlw for manitaring G Developer

9. Chon Next

Pleasze select inztall components.

[~ Import from Melzec Medoc farmat file(printout).

[T Import from Melsec Medoc format file.

Cancel |




10. Chon duong dan dén noi chra thu muc cai dit phan mém , néu ddng y véi duong
dan mac dinh caa phan mém thi chon Next , muén chon duong dan khac thi chon
Browse , sau d6 chon Next dé tiép tuc viéc cai dat chuong trinh

The zetup will inztall SWwWnDS-GPPW in the fallowing directorn.
Click. [Mext] to inztall in this directory.

Click [Browse] and zelect the directory for installing in other
directany.

Click [Cancel] for nat installing.

D estination Folder

C:AMELSECH Browsze...

3.2.3 Cai diat phan mém GX Simulator 7 .

— Phan mém GX Simulator 7 1a phan mém gia lap PLC, dung dé kiém tra chuong
trinh trudc khi nap vao PLC .

— Cai dat phan mém GX Simulator 7 ciing twong ty nhu cai dat phan mém GX
Developer .



3.2.4 Cai dat driver cap lap trinh USB-SCO09 .

Cai dat driver cap lap trinh USB-SCO09 cho may tinh dé két néi giira may tinh va PLC
Mitsubishi .

AT Bl T

L 1:;;‘“:"-:-‘-:
PLC
built-in part
(R5-422)
FX-422CABOD ‘% ~ —

FX-232AWC-H
[RE-232C/A5-422 convartar)

Hinh 3.1 So d6 két ndi may tinh véi PLC.
Huéng din cai dit :
— Pong tat ca cac cira s6 dang lam viéc lai .
— Dua dia cai dat driver USB-SC09 vao 6 doc CD-ROM.

— Kich hoat CD-ROM.
— Vao Folder cai dat driver USB-SC09 .

1. Kich dap vao file CP210x_VCP_Win2K_XP_S2K3

» Computer » CD Drive (E:) 328952 » Other Driver » CP210X » win7 & vista

File Edit View Tools Help

Organize ¥ Share with « New folder
. - . fie s
X Favorites Name Date modified Type
Bl Desktop = CP210x_VCP_Win2K_XP_S2K3 7/15/2008 4:09 PM Application

& Downloads
~. Recent Places
#& OneDrive

~a Libraries
*| Documents

&' Music I

&= Pictures Kich dup vao file
B videos CP210x_VCP

& Homegroup



2. Chon Next

ol e ™y
Silicon Laboratories CP210x VCP Drivers for Windows 2000/XP/2003 Server/Vista - ... (et
R ——

Welcome to the InstallShield Wizard for Silicon
- Laboratonies CP210x VCP Dnvers for Windows
20007<P /2003 Server/Yista

The InztallShield Wizard will copy Silicon Laborataries
CP210x%CP Drivers for Windows 2000P 2003
Serverizta onto your computer. To continue, click, Mext.

3. Tich vao ” I accept the tems of the license agreement ”, sau d6 chon Next

|
Silicon Laboratories _‘.'ﬁndmus 2000/XP/2003 Server/Vista - ... IS

License Agreement

Please read the following licenze agreement carefully.

EMD-USER LICEMSE AGREEMEMT
IMPORTANT: READ CAREFULLY
BEFORE AGREEIMG TO TERMS

THIS PRODUCT COMTAINS CERTAIN COMPUTER PROGRAMS AMD OTHER THIRD
FPARTY PROPRIETARY MATERIAL ["LICEMSED PRODUCT ™. THE USE OF WHICH IS5
SUBJECT TO THIS EMD-USER LICEMSE AGREEMEMNT. INDICATING YOUR
AGREEMENT COMSTITUTES vOUR AMD [IF APPLICABLE] YOUR COMPANY"S
ASSEMT TO AMD ACCEPTAMCE OF THIS EMD-USER LICENSE AGREEMEMT [THE
"LICEMSE" OR "AGREEMEMNT"). IF%0U DO MOT AGREE “ITH ALL OF THE
TERMS, ¥OU MUST MOT USE THIS PRODUCT. WRITTEM APPROWAL 1S NOT A

PO S T T T A AL I T i C RO T AN TS O TS A e L e T

@) | accept the terms of the license agreement

() | do not accept the terms of the license agreement
InztallShield




4. Chon dudng dan dén noi chira thy myc CP210_VCP , néu dong y voi duong dan
mac dinh caa phan mém thi chon Next , mudn chon duong dan khac thi chon Browse ,
sau d6 chon Next dé tiép tuc viéc cai dit chuong trinh .

PSilicon Laboratones LS

Choose Destination Location

Select folder where zetup will inztall files.

Setup will install Silicon Laborataries CR21 08 W CP Drivers for wWindows 2000-P /2003
Serverizta in the following folder.,

To inztall ko this Folder, click Mext. To install to a different folder, click Browse and select
another folder.

Drestination Folder

c:hSilabsihkCL

InztallS khield

5. Chon Install dé cai dit , chon Back khi muén quay tro lai trang trude do

|y p——

Ready to Inztall the Program

The wizard iz ready to beain installation.

Click. Install to begin the inztallation.

If wou want to review ar change any of pour installation settings, click Back. Click Cancel to exit
the wizard.

Inztalls hisld




6. Tich vao 6 vuéng Launch the CP210x VCP Driver Installer , sau @6 chon Finish

Silicon Laboratories CP210x VCP Drivers for Wi 3 Server/Vista - InstallShi...

The InzstallShield *Wizard has successfully copied the Silicon
Laboratories CP210: WP Drivers for Windows 2000/5P/2003
ServerMVizta to pour hard drive. The driver installer listed below
zhould be executed in arder ta install drivers or update an
exizting driver.

Launch the CP210x%CP Driver Installer.

Click Finigh to complete the Silicon Laboratones CP210x WCP
Dirivers far Windows 20005=P 2003 ServerMista setup,

< Back Cancel

7. Chon duong dan dén noi chira thu muc Driver USB-SCO9 , néu dong y véi dudng
dan mic dinh caa phan mém thi chon Next , mudn chon dudng dan khéc thi chon
Change Install Location...

Silicon Laboratories
Silicon Laboratories CP210x USE to UART Bridge

Installation Location: Driver Version 5.3

C:\Program Files (x86)\Silabs\MCLUNCP 210k,

Change Install Location. .. | [m Cancel |




3.3 Hwéng din sir dung phan mém GX Developer.

3.3.1 Mé phan mém lap trinh .

Kich dup chudt trai vao biéu tuong phan mém GX Developer trén man hinh
Windows hay nhan chuét vao Start > Programs ( All Programs ) > MELSEC
Application > GX Developer .

mmia...

Kich dap vao biéu

tugng phan mém

lap trinh

G | 2]

3.3.2 Tao mgt project méi .

1. Khi da vao phén mém kich chuot trai vao @ MELSOFT series GX Developer

Project > New project , hoic nhin t6 hop [Project| Edit Find/Replace View Online Diagi

phim Ctrl + N dé tao mot Project méi . CtrieN

Open project ... Ctrl+0

Close project
Save Ctrl+5

hoac kich chuét vao biéu tuong —I trén thanh céng cu .



2. Hop thoai New Project s& xuat hién :

Chon kiéu PLC

Chon ho PLC ~_|

-

Mew Project

B )

PLC zenes

ak.

> [RucrU

FLC Type

=]

Cancel

—=> | FH2H(C]

— Program type
* Ladder

Chon ngdn ngir 1ap trinh

Tich vao dé luu project

I MELSAP-L

-]

— Label zetting
¥ Do not uze label

" Use label

[Select when uzing ST program,
FB and structures)

DPuong dan luu trit project

S [iivedPath

Dat tén project

Dit tiéu dé project

Froject name

7Tltle

— Setup project name

N :
v Setup project name

™ Device memary data which is the same az program data's name is created.

CAMELSECNGPFW

Hinh 3.1: Hop thoai New Project

Chon noi luu trir khac




3. Sau d6 chon OK dé Iuu thiét 1ap va xuat hién man hinh soan thao chwong trinh :

¢ MELSOFT series GX Developer C:\MELSEC\Data\MODULAR-PROGT - [LD{Edit mode)  MAIN 35 Step] - |8 [IX
— Project Edt FindfReplace Convert View Onine Disgrostcs Toos Window Heb - R
D@l 8| $ o] QGRS 46 alal E@ Fon -] = sl

WYL SIRE | BEES LS

S =l o|r] mieela WS 212] ) @) 23] el

~
0 oo ]
v
Resdy Qs Host o O

Hinh 3.2: Man hinh soan thao chuong trinh GX Developer



3.3.3 Moi truwong lap trinh phan mém GX Developer .

a) Cé&c biéu twong trén thanh cong cu :

A

y hiéu

D>

Y nghia

Lénh tao mét project mai.

Lénh m¢ file da luu .

Lénh luu dix liéu dudi mot tén da co san.

Lénh in toan bd chuong trinh diéu kién.

Cat mot doan 1énh vira chon.

Sao chép mot doan Iénh vira chon.

Dan mot doan Iénh vira copy.

Huay bo Iénh vira thuc hién.

Khac phuc lai [énh vira thyc hién.

Tim kiém vi tri cac cong logic co trong chuong trinh.

Tim kiém vi tri cac cdng logic theo tiép diém co trong chuong trinh.

@5 (®F D

Tim chudi ky tuy trong chuong trinh.

$

v

Nap chuong trinh diéu khién vao PLC.




Doc chuong trinh diéu khién tir PLC.

L4y dit liéu dang giam sat.

Giam sat diéu khién theo khdi.

Gia lap céc cong logic bi tac dong ( dung chung GX Simulator ).

AR

Kiém tra tham sé PLC.

b) Thw vién Iénh logic dwéi dang Ladder.
Cac chir viét tat dudi cac biéu tuong lénh logic twong (ng véi cac phim chirc ning sau

e S:Phim SHIFT . Vidu : sF5=SHIFT + F5.

e C:PhimCTRL.Vidu:cF9= CTRL + F9.

e A:PhimALT.Vidu:aF7=ALT+F7

e Ca:PhimCTRL + ALT.Vidu:caF10=CTRL + ALT + F10.

Ky hi¢u Y nghia

L1 | Tidp diém thuong mo , tiép diém s& dong khi tin higu vao mic ON (*17) .
:FEI Tiép diém thuong mé song song .

‘L’Fﬁl‘ Tiép diém thuong dong , tiép diém s& mé khi tin hiéu vao mic OFF(“0”).
| SLFIE | Tiép diém thuong dong song song




Cudn day (dau ra tin hiéu).

Fr
| {FB} Lénh tao ham truyén dat.
Fo Lénh tao mach thang nam ngang.
5'1_9 | Lénh tao mach thiang ndi doc
j:ig Lénh x6a mach thang.
o Lénh x6a mach néi doc.
4tk | | Tiép diém suon 1én , tiép diém tao ra mot xung khi tin hiéu vao thay doi tir
sE 7| muc 0 1én muc 1.
4L | | Tiép diém suon xudng , tiép diém tao ra mot xung khi tin higu vao thay doi
sF5 tir muc 1 xudng mic 0.
I_j;l:ll.l Tiép diém suon Ién song song.
j};‘; Tiép diém suon xudng song song
-::a:F1I:I Lénh NOT dao gid tri logic tai ngd ra.
I_:% Tao mach chidu doc va chiéu ngang véi chuot
—a% Xda mach chiéu doc va chiéu ngang vai chuot




3.3.4 Phan biét ché @ Write mode va Read mode.
a) Ché d§ Write mode (ché @é ghi) .

Ché do ghi phai dugc kich hoat thi méi c6 thé viét va chinh sira chwong trinh .

(4 v

Kich vao Write mode trén thanh cong cu : ﬁ__f
ﬂh[""-' n

Ché d6 doc duogc sir dung khi xem hozc tim kiém cac 1énh trong chuong trinh , luu ¥
khdng thé thuc hién dugc bat ki sy chinh sta nao trong chuong trinh khi dang & ché do
doc.

El 5— -+ .-I *l
Kich vao Read mode trén thanh cong cu: | T T ||L-T ||L-T

3.3.5 Phan biét ché dp Ovrwrte (viét dé) va ché dd Insert (viét chén)

b) Ché @6 Read mode (ché dd doc).

Trude khi budc vao soan thao chuong trinh , can biét chuwong trinh dang & ché
d6 ndo , mic dinh chuong trinh 1a & ché do Ovrwrte , vi & mdi ché d6 chuong trinh s&
xu ly khac nhau .

Viéc chuyén doi giira ché do Ovrwrte va Insert bang cach nhan phim Insert .

Chuong trinh & ché d Ovrwrte :

0 [END 1
\ Con tro chuot

mau xanh duong

FXZN(C) Host station NUM



Chuong trinh & ché d Insert :

0 [END ]
\ Con tré chudt

mau tim

FX2N(C) Host station NUM

Céch soan thao chuong trinh theo tirng ché do s& duogc trinh bay rd & cac muc phia sau.
3.3.6 Nhap Iénh logic co ban .

1. Bat con tré tai vi tri mudn nhap Iénh.

r
0  END

2. Chon lénh can nhap trén thanh céng cu , hoic bam phim chuac ning twong ung, gia
sir chon tiép diém thuong mo (F5), sau d6 sé xuat hién hop thoai Enter Symbol , ngoai
ra hop thoai con xuat hién khi ta danh tén 1énh .

Entersymbol |
ﬁh R | 1.4 | Eat | Hl:b|
00 ©

€© Nt nay c6 2 biéu twong khi nhap vao:

at
— Khi biéu tugng EJ nay hién thi , hop thoai Enter symbol s& dong lai
khi chon OK hoic nhan phim Enter .



— Khi biéu tugng |I:| nay hién thi , hop thoai Enter symbol vin még khi
chon OK hoic nhan phim Enter , hop thoai chi déng lai khi chon Exit.

@© Ban diu ta da chon Iénh logic trén thanh PErS—

fntersymbol
cong cy, hoac phim chttc nang , nhung ta cling g|4| R E I Hehl

c6 thé chon lai Iénh bang cach kich chudt nhu 1"
hinh bén , danh sach cac Iénh s€ hiénra .

Wi Kich chuot

0 [END }

Luuy:

Ta ciing c6 thé chinh sta lai 1énh logic da nhap, bang cach dat con tro tai Iénh
d6 va 1am nhu cach trén nhung két qua s& khac, phu thudc vao ché d¢6 Ovrwrte
hay Insert .

Vi du : Thay tiép diém thuong mg X003 bang tiép diém thudng dong X005.

Két qua 1a néu chuong trinh dang & ché d6 Ovrwrte , thi tiép diém thuong mo X003
s& dugc thay thé bang tiép diém thuong déng X005 , con néu chuong trinh dang & ché
do Insert, thi tiép diém thuong déng X005 s& duoc thém vao chuong trinh, & Vi tri
phia trai tiép diém thudng mg X003.



Ché d Insert (viét chén)

Ché @o Ovrwrte (viét de)

M1 X003 M1 X003
0— | | 0— | |
Enter symbol Enter symbal
gl ~ljxom = | T
M1 X005 X003 M1 X003

3.6 Chén hoic x6a cac dwong két ndi mach .

C6 2 cach dé chén hoic xoa cac dudong két ni mach:

Céach 1: St dung cac Iénh chen va xo6a trén thanh cong cu : Fa | <Fa|cFa | oo

Gia sir chén duong két ndi mach theo chiéu doc , dit con tré tai vi tri mudn chén , sau
| ,

d6 kich vao SF2  trén thanh cong cu , hodc bdm phim SHIFT + F9 , hop thoai Enter

vertical line s& xuét hién .



X001
0 I I (YU 02
? [ Enter vertical line @1 [END }
{@ [ e |

Nhap sé duong két ndi doc mudn chén , néu khong nhap bat ki gia tri nao , thi s& duoc
chén theo mic dinh 12 1, sau d6 chon OK hoic nhan phim Enter .

0 — | (Y002 )

2 EEND }

Lénh x0a ciing thuc hién twong tu nhu 1énh chen .
Céch 2: Str dung Iénh chén va xda trén thanh céng cu : ;'% ;[;"g

—
Khi LEIO} duoc kich hoat, ta cd thé v& cac duong ngang va doc mot cach nhanh

chong va dé dang vai chudt. Bt con tro tai vi tri mudn bat dau vé , sau d6 bam va git
chuot tréi , kéo chuot dé vé duong két ndi . Tha chudt trai tai diém mudn két thic .

0— | (1002 Y

2 [END }




(Y002

Lénh x6a ciing thuc hién tuwong ty nhu 1énh chén , nhan giir chudt trai va kéo trén dong
mudn xda . Cac dong sé bi x6a khi tha chudt tréi .

3.7 Chén va x6a hang trong chwong trinh.

3.7.1 Chen hang

Pé chén mot hang méi vao chuong trinh, dat con tré tai vi tri hang muén chén |, luu y
hang mai dugc chén s& nam trén vi tri dat con tro .

r
| END

Trén thanh Menu chon Edit > Insert Line (Shift + Insert) , hoic nhan chugt phai

chon Insert Line .

tri muén chén hana

X001
0 | (1002
X005 X001
2| £ (Y003
X004
| (Y005
7 bat con tro tai vi [END

)

j




X001
| | IS
o— | (Y002
X005 chlliWH Ctrl+Z
ndo rl+ p
2 - (Y003
Cut Ctrl+X
_XOO Z ;opty E:rll+C
aste Ctrl+V
Sy | (1005
Delete line Shift+ Del Chon Insert line
7 Insert row Ctrl+Ins ’ rEND
Delete row Ctrl+Del L
X001
0— | (Y002
X005 X001
2|t (xoo3
X004
| | (Y005
7 [END

3.7.2 X6a hang

Cach thuc hién ciing tuwong ty nhu chén hang , chon hang muédn xéa , roi chon Edit >
Delete line (Shift + Delete) .

3.8 Chén va x6a tiép diém trong chwong trinh .
3.8.1 Chen tiép diém

Khi chuong trinh dang ¢ ché d6 Write mode , dé chén mét tiép diém mégi nam
& phia tréi tiép diém c6 sin (X005) , dat con tré tai vi tri tiép diém c6 sdn (X005) nhu
trong hinh dudi .




X001
0 | | (Y002
X005 X001 Y006
2 | (ro0s
%004
} } (Y005
10 [END

Trén thanh Menu chon Edit > Insert row (Ctrl + Insert) , hodc nhan chuét phai chon

Insert row .
X001
| | s
0— | (Y002
X005 Hv‘nm wANE o
Unde Ctrl+Z
2— (Y004
Cut Ctrl+X
W lfo;:)r E:rl|+C
aste Ctrl+V
— | , (Y005
Insert line Shift+Ins
Delete fine Shift+ Del / Chon Insert row
10 Insert row Ctrl+Ins - rEND
Delete row Ctrl+Del L
X001
0— | (1002
X005 X001 Y006
z | (1001
X004
| (Y005
10 [END




3.8.2 Xo6a Tiép diém.

Céch thuc hién ciing tuong ty nhu chén tiép diém , chon tiép diém can xéa , roi
chon Edit > Delete row (Ctrl + Delete) , hoic bAm chudt phai chon Delete row.

Ngoai ra con cd thé xd6a bang cach bam giir chudt trai , kéo chudt chon nhitng phan
tar muén x6a , rdi bAm phim Delete.

3.9 Cit (Cut) , sao chép (Copy) va dan (Paste) trong chwong trinh .

1. BAm va giir chudt trai dé chon nhirng phan tir can dwoc cat hoic sao chép

(Y004

r
| END

2. Chon Edit > Cut (Ctrl + X ) khi mudn cat , hay Edit > Copy (Ctrl + C) khi
sao chép , hodc bam phai chudt chon Cut hay Copy .

(1004

Undo Ctrl+Z

Cut Ctrl+X

1‘!!.1 Ctrl+C

Paste Ctrl+V

r
| END

Insert line Shift+Ins

3. Di chyén con tro dén vi tri can duoc déan , sau d6 chon Edit > Paste (Ctrl +V)

X005 X001
0| (008
X004 X003
| | | |
|

r
6 | END

)

j

]

)

j



4. Két qua dan sé& khéac nhau giita ché 6 Ovrwrte va ché do Insert .

Ché d Insert: Ché ao Ovrwrte:

X005 X001
[ \ 1
| \ %004 %003
| | | |
X?Oﬁ X?[TB Tiép diém duoc dan | |

nhay sang mot hang mai

3.10 Chuyén ddi chwong trinh (Convert).
Sau khi viét hoic chinh stra chuong trinh, nhin vao Convert trén thanh menu (hoic

8
F4) hay nhan vao biéu tugng | dé chuyén doi chuong trinh . Budc nay

phai thuc hién thi méi nap chuong trinh diéu khién vao PLC . Sau khi chuyén doi , néu
chuong trinh ding ct phap 1énh, thi man hinh soan thao chuyén tir mau xam sang mau
tring , néu sai s& hién ra théng béo 13i tai vi tri con tro dang .Phai chinh sta 15i tai vi tri
con tro thi viéc chyén d6i méi hoan tat .

0— | —(v007 ) 0— | (1007

[ r
3  END } 3  END

U U




MELSOFT series GX Developer e e X005
0 | | (Y007
[ \
l.-"'_"“‘-.l There is a ladder which cannot be converted,
‘W Correct the ladder at the cursor position. X004
- | |
[
r
\ ) 3 [END

3.11 Nhap va hién thij céc &1 cha thich trong chwong trinh.

GX Developer ¢ 3 chirc nang dé nhap chu thich trong chuong trinh .

— Device comments — chu thich cho cac 1énh logic.

— Statements — ghi chll dau hang.

— Notes — chd thich cho thiét bi du ra .
Luu ¥ : Dé c6 thé nhap cha thich trong chuong trinh thi chuong trinh phai dang & ché
do Write mode.

3.11.1 Device comments — chi thich cho cac Iénh logic

% Nhap chu thich khi viét xong chwong trinh.
4
1. Trén thanh cong cu nhan vao biéu tugng HERE @€ Kich hoat , nhan lan nita dé
tat kich hoat chu thich 1énh .
2. Dat con tro tai 1énh can ch thich va nhap déi chudt .

ElU Ell
| | ¥

0 b— | 1 Y2 0 1

\ MO
Nhap doi chudt

[STaRT START

Nhap loi cha thich




3. Chon OK sau khi nhap xong 161 chu thich.

‘ 2010 K01
| | | (
0 | /{ \YOZO
START MOTOR
< Nhaip chii thich trong khi dang viét 1énh .
1. Trén thanh Menu chon Tools > Options .
2. Khi hop thoai Options duoc hién thi, kich chon Continues during command
write .

£

Plogiam o | Each eogram | Whaie deta | TEL |

Echl olbject Fhl lowaid selling] ~ Al Eofvatsion wivng bahaol i
¥ Coniruous ladder block " Wrle dusng RUN jwhis PLC iz unring] Carree
[Shit the progeam o) " Wrile § PLC S5TOP B
™ 1 ladder block ¥ Dioet wte b PLC
[Cvon't shilt e program fonward|

¥ Absokbe shep Mo [dsfauk]
e -

AT e g i
[ Checks or double cals duing wile Y R TIT —
£ CRU statemer | - Show/don't show character g Macro
" [GFF sislsmeni I Cormonio sl oag
N : fri
:hsmn':rnluh | —
- Ladder masitor of PLS/PLF insinaction

- R ——
— iy er.ti:h-rrrl:rh:rfu'F?lI-iF':ljmTl

Hinh 3.4: Hop thoai Options.



Dénh 1énh va nhép 161 chu thich nhu sau:

1. Nhéap Ié€nh

j}  =[pD ak m|mp|

A~ . . - .
2. Hop thoal Enter device comment Enter device comment [ X010 ] COM... ﬁ

duoc hién thi ngay sau do.

Cancel

START

% Nhap chi thich truéc khi viét chwong trinh .

1. Kich chudt vao biéu tuong ‘EI trén thanh cong cuy, dé xuét hién cira s

project data list.
2. Tu project data list chon Device Comment > COMMENT .

=l . (Unset project)
@ Program
= Eﬂ Device comment
BCOMMEND
@ Parameter
@ Device memory -

Hinh 3.5: Ctra s6 project data list




3. Xuét hién bang nhap ch thich cho cac 1énh , nhép tén 1énh sau d6 bam Display .

Dievice name [+000 j Diizplay

Device name Comment Alias
X000 Khol dong Start

X001 ung Stop

X002
X003
X004
X005
X008
X007
X010
X011
X012
X013
X014
X015

Hinh 3.5 Bang nhap chu thich cho cac Iénh logic.

e Device name : nhap tén Iénh .

e Comment : nhéap chu thich cho 1énh .

e Alias: nhap tén thay thé cho tén 1énh , c6 thé hién thi cing tén 1énh, hodc
chi hién thi tén thay thé .



3.11.2 Display device comment — Hién thi chii thich I1énh logic .
Trén thanh menu chon View dé kich hoat hodc v6 higu hoa hién thi céc 1énh.

| Viewy
v Comment Cirl+Fs +——— Display device commaent

Statement Crril+F7

v Alas Alt+Ctl+F5 44— Display alias

Macra inst or spley Alias display mode
Comment format ' kf’/

Abas format display b

Device program display mode k

Replace device name and display
Toolbar ...
v Status bar

Zoom ...

v Progect data list Alt+0
Project data dsplay format [

Alias
Instruction list Alt4F1 Start

- X000
| |

Set the contact 3 Device name

Elapsed time .I |
Display sten synchronizatio PR A2 Comment ——EKhol dong

Alias display mode c6 hai ché d6 dé hién thi :
— Replace device name and display — tén thay thé (Alias) thay thé cho tén cia
Iénh.

‘ start
‘ | | (Motor




— Arrange with device and display — tén thay thé (Alias) hién thi cing tén 1énh

start
X000

Motor

3.11.3 Statements — ghi ch( dau hang.

(1002

Em
1. Trén thanh cong cu nhan vao bi€u tugng dé kich hoat , nhan lan nira dé
tat kich hoat ghi chi .
2. Pit con tré ¢ bat ctr noi nao trén mot hang can ghi chii ,va nhap doi chuot .
X000 X001
| | | (
e (003
Y002
I I Enter symbel @
@| j|MotorStarﬂ Esit ‘Helpl
Nhap 16i chi thich
3. Chon Ok , r6i bAm phim F4 dé chuyén d6i .
* Motor Start
%000 X001
| | /
0—{ | /" 1002
1002

_{

)

)




3.11.4 Notes — ghi chu cho thiét bi dau ra.

1. Trén thanh cong cu nhan vao biéu tuong

kich hoat ghi chu .

e X 1,1 A 1A o R L%
=< >1 dé¢ kich hoat , nhan lan nira dé tat

2. bat con tré ¢ cudn day dau ra , va nhap doéi chudt .

X000 X001
| | | /
| 1002
Enter Note @1
Y002
I I ® Sopade ‘Motuanvd \
Esit
Nhap loi cha thich
3. Chon OK , r6i bAm phim F4 dé chuyén doi .
* (Motor Drive
X000 X001
| | | (
v (1002
Y002
]
3.11.5 Hién thi Statements va Notes.
Trén thanh Menu chon View > Statements
(Note) dé kich hoat hodc vo hiéu héa hién thi
.o Comment Clri+F5
ghi chu .
v Statement Cirl+F7
v Note Ctrl+F8

Alias Alt+Cirl 4F6




3.12 Find - Tim kiém.
Chtrc ning Find trong GX Developer rét hiru ich khi ta viét mot chuwong trinh 16n
V61 hang tram , hang ngan [énh .
3.12.1 Find Step Number .
Tim kiém duya vao sb budc lap trinh .
1. Ttr thanh Menu chon Find / Replace.
2. Chon Find step no.

[inlEEd el Convert Wiew Online  Diagnosti

Find device ...

Find instiuction ..
Find step no, ...

Find character string
Find contact or coil Al Cul+F7

3. Xuét hién hop thoai Find step no.

Danh sb budc can tim kiém

4. Chon OK , ngay lap tirc chuong trinh nhay dén s6 budc da nhap.

3.12.2 Find Device .
Tim kiém dua vao tén 1énh trong chuong trinh .
1. Tt thanh menu chon Find / Replace.

2. Chon Find device. [Flﬂdfﬂeplﬁ]_iunvert View Online Diagnastics

Ctrl:F

Find instruction ...

Find step na. ...
Find character string ..
Find contact or coll Alt+Ctrl+F7



3. Xuét hién hop thoai Find device :

Find device X]

Nhap tén Iénh

can tim kiém

1

Device

r

Find direction

* From top to bottom
" From cursor to bottom

" From cursor to top

d

EiCd

Close

Find option

* None

" Digi

" Double word

Hinh 3.6: Hop thoai Find device.

4. Sau d6 bAm Find Next dé tim kiém .

Luwu ¥ : trong chuong trinh c6 bao nhiéu tiép dém , cuén day ma c6 chung mét tén Iénh
, thi bAm Find Next bay nhiéu 1an, cho dén khi xuat hién hop thoai Find is complete.

MELSOFT series GX Developer @

L
‘y Find is camplete.

kK,

5. BAm OK dé két thic qué trinh tim kiém .




3.12.3 Find Instruction .
Tim kiém dya vao céu tric 1énh logic va tén Iénh.
1. Ttr thanh menu chon Find / Replace > Find Instruction .

2. Xuét hién hop thoai Find Instruction :

i T
Find instruction ﬁ

Chon cau Instruction Fird Mext

\| 14 j 1 ﬂ Close

/

trac 1énh logic

Nhap tén Iénh

Find direction

{* From top to battam
" From cursar bo bottomn

" From cursor ta top

Hinh 3.7: Hop thoai Find instruction

3. Bam Find Next dé tim kiém, cho dén khi xuat hién hop thoai thoai Find is

MELSOFT series GX Developer [X]
jj) Find is complete.

K,

complete.

4. Bam OK dé két thaic qua trinh tim kiém .



3.12.4 Cross Reference List

Tim kiém dua vao tén Iénh logic, két qua tim kiém Ia dang danh sach, hién thi
tat ca s6 budc, cau tric logic ¢6 chung mot tén 1énh can tim kiém trong chwong trinh .

1. Tu thanh menu chon Find / Replace > Cross reference list .
2. Xuat hién hop thoai Cross reference list , nhap tén Iénh , sau d6 bAm Execute dé
hién danh sach két qua tim kiém .

YT — i
: Targe
- s o
Nhap ten |enh —> (M50 =] | & Device program Clote I
Find range ¥ i
|MaIN ~] e I
* None
" Digt
" Double wand
Comment

|

Elock] Sb@l Sequence stepj Instructi | Pos.. | Progiam name
3 {}PLS . MAIN
, Z 3 4k X MA':JN
Danh sach ket / B4 b MaIN
/
qua tim kiém
«| | »]

Hinh 3.14: Hop thoai Cross reference list.

4. Bé hién thi sb budc twrong tng trong chuong trinh so v6i danh sach két qua tim kiém
, ta chon s6 budc can hién thi , sau d6 bam chuét trai chon Jump .




3.12.5 List of Used Devices

Chtic nang nay cho biét cac tén 1énh logic dang sir dung trong chwong trinh dudi
dang danh sach ,cling nhu cac tén 1énh chua qua st dung.

1. Tu thanh menu chon Find/Replace > List of used devices .

2. Xuit hién hop thoai List of used devices , nhap tén lénh can tim kiém , sau
d6 bAm chon Execute .

List of used devices (MAIN)

" Target the whole program Execute

* Specify the target program |MﬁIN ﬂ Nhap tén I¢nh Close

Find device |MES |
= o
{* Device pragram u

" Cizplay range M [ E8- &)

Device - I-|-( }J- | Count | Unpaired Comment
M&8 = E 1

M69 /

M70

M71 /|

2 7 Dau sao chi thi 1énh dugc str dung cho cuon day ——

M3/

DA4u sao chi thi lIénh

duoc st dung cho tiép diém

[ N

M78

M79

MEO

MEl

N

Hinh 3.8: Hop thoai List of used devices.



3.13 Giao tiép véi PLC 40 .

Truéc khi giao tiép véi PLC | ta nén giao tiép véi PLC ao , dé kiém tra chuong
trinh da chay ding hay khong .
1. Dé giao tiép véi PLC a0 , bam vao biéu tuong E trén thanh cong cu .
2. Sau d6 sé& xuat hién hai sy thay doi nhu sau:

— Xuét hién hop thoai LADDER LOGIC TEST va Monitor status

-

B LADDER LOGIC TEST TO.. l‘:' | | ad 'r Monitor status @

Start Tools Help p 100ms|  RUM RéM
N

F2N(C) / Y

Thai gian chu ky Ché do CPU

RUN  ERROR

SWITCH +—1 Tat PLC a0
INDICATOR RESET | | ¢ stopé— | |

{¢ UM

Bat PLC 40
[0 SY'STEM

RuN BN

— Man hinh hién thi chuong trinh :
v Trudc khi giao tiép PLC 40

X001 X002 X007 M7
a +F i +F (Y022 )
M67 X030 K20

a i (10 )




v Sau khi giao tiép PLC a0

X001 X002 X007 M7
| & A & (Y022 )
M67 X030 K20

| | Jgf (TO )

Sau khi giao tiép vai PLC 4o, cac lénh hién thi trang thai hién thoi ON/OFF.

Trang thai OFF : ‘{ B ;H: {T:lillj'r { }

; A

e
Dé ngirng hién thi trang thai hién thai cua lénh, kich chudt vao biéu tuong TE

Luwu y : Sau khi nap chwong trinh vao PLC 40 , ma mudn chinh stra lai chuong trinh thi
phai tat hién thi trang thai hién thoi caa lénh | roi méi chinh stra chuong trinh , sau khi
chinh stra hoan tat , phai cap nhat chwong trinh méi cho PLC ao bang cach :

1. T5t PLC 40 .

7 - _ :
2. Kich vao biéu twong EEI° | hoac tir thanh menu chon Online > Write

to PLC.

3.Xuat hién hop thoai Write to PLC , tich chon Main , sau d6 bam chuot tréi
chon Execute dé nap chuong trinh méi vao PLC 40 .



-
Write to PLC

ai————————————.

Connecting interface IGX Develaper

PLLC Connection

T arget memony

File selection | Device datal F'ru:ugraml Eu:ummu:unl

Param+Frog | Select all | Cancel all selectiunsl

= _Tite ]

PN ILLT

Metwork Mo, 3 Station Mo.[Host  PLC wpe JF<2NIC

E Program
M MaNE——

Tich chon Main

EI@ Device camment
i |:| COMMEMNT

EI@ Pararneter

— Related functions

Transfer zetup...

Evecute |
Cloze |

F.eward setup...

Remote operation..

Redundant operation.

Clear PLC memory. .

Format PLC memary... |

Arrange PLE memor_l,l...l

Create title....

Free zpace valume | vl

Largest contiguous

Butes

Total free space
wolume

Butes

Hinh 3.9: Hop thoai Write to PLC

4. Xuat hién hop thoai Excute write to PLC :

MELSOFT series GK Deve
!"_-. Execute write to PLC?

Chon Yes

—

Y5

I w ]

5. Xuat hién hop thoai Completed, chon OK dé
hoan thanh viéc nap chuong trinh vao PLC ao.

6. Bat PLC ao.

_ir) Completed.

[ o |

x|

X|




3.14 Giam sat va gia lap tin hi¢u tac dong .

Trong luc hién thi trang thai hién thoi caa lénh
dong dau vao va giam sat chuong trinh .

3.14.1 Device Test.

Device Test duoc dung dé gia 1ap tinh hiéu tac dong .

1. Kich chuét trai vao biéu tuong a‘ trén thanh cdng cu , hoic chon lénh can tac

dong , roi nhan chudt phai chon Device test .

2. Xuéat hién hop thoai Device test .

, ta cd thé gia lap tin hiéu tac

Device test 22
Bit device — e
Device Close
001 =]
Hide history
FORCE ON | FORCE OFF |  Toggle farce | _ Hids history |
word devicesbuffer memaory
+ Device | ZI
" Buffer memory
I =] [oec =]
Setting values
[EC =] [15bitinteger | set
Program
Label reference program | J
E =ecution histony
Device | Setting condition |
=00 Force OFF
=00 Force OM
Clear

Hinh 3.10: Hop thoai Device test.

€© Nhap Iénh cén tac dong .
@ Budc Iénh chuyén sang ON.

€ Buoc Iénh chuyén sang OFF.




3.14.2 Device Batch Monitor .

Device Batch Monitor duoc dung dé giam sat trang thai ON/OFF hién thoi cua cac
Iénh trong chuong trinh.

1. Kich chudt vao biéu tuong @ trén thanh cong cu .

2. Xuét hién hop thoai Device batch monitor , nhap tén Iénh dau tién , sau d6 bam
Start monitor hoic nhan phim Enter , GX Developer sé hién thi trang thai hién tai cua
Iénh nhap va céc 1énh ¢ phia sau [énh d6 .

e 1.0N
e 0:OFF
H Device batch monitor-2 =10l x|
Devis: [0
Morilar feemal: 8 Bite'word  Display 8 16kl inleger Vaue v DEC T/C zef value
Redesence program
i~ Bit " 32t mbe ™ HEX
[ mbeger VAN =
™ whord " Aeal rmbe
" ASCI characie: Q
Stop marbor
Device +tF EDC tBADE #7654 +3 210 ﬂ
il d44aa s} 4 a 14600 24 Dption setup
juF] G000 oo o0 2 9000 1]
03 0200 1001 1111 1011 1555
- C oo - — e -
it} 4a4aa s o i s 1111 4 Dievica bast
=] G048 o006 1111 1111 55
(s @000 o0 P 0@9Q 0000 [
D7 o 4 O oo O 0O 90 0000 [
D 2aaa0 00 b 0 a G000 Q Claze
D& @aaa oooo o a a aooao a
o] 604080 0000 G844 0000 a
o aaa0aQ 10 1 o2 1 i010 4843
i daaa0 oo o 0 a a000 a
Diz aaaa oo s84a 0000 a
D13 aaa0 o0 G800 0000 a
Bl4 @aaaQ oo o a2 a aoo0 ]
r ] o000 00 o a0 9 0000 0
g G081 0001 11 0111 4587
D17 G000 o0 o0 000 a] =|

Hinh 3.11: Hop thoai Device batch monitor

Ngoai ra néu mudn thay ddi trang thai hién tai cua lénh nao thi nhan vao Device test .



3.14.3 Timing Chart .

Timing chart 1a mot dang biéu 6 ON /OFF rat tién loi dé ta c6 thé thay ddi trang
thai cua lénh , ddng thoi gidm sat trang thai hién thoi cua lénh dudi dang biéu db.

1. Tt hop thoai LADDER LOGIC TEST TO, chon Start > Monitor Function >

Timing Chart Display .

5

B LADDER LOGIC TEST TO... [ =l — —"—I

Start | Tools Help

I

Moniter Function 3

IO System Settings

Device Memory Monitor
Timing Chart Display

Serial Communication Function

Device Manager

~SwITCH
INDICATOR RESET | ~ sTOP
¢ STEP RUN
~1/0 SYSTEM
run

A

2. Xuét hién hop thoai Timing Chart .

-

” ) - e = g‘
EF Timing Chart — l P — - =
File Device Monitor
haonitar Status Device Entry Chart Dizplay B ange
’7 Maritaring £ ’71"' Auto ﬁ; M ariual ’7 ool Xz xR O x®i0 O x20
/ -10 -a\ 4 7 B 5 4 \-3 2 1 [0
/ I \ =
A &n tir ché do -1 Bam chon Manual .
Bam chuyén tir che do am chon Vianua Chon pham vi
Monitor Stop - Monitoring hién thi bieudo ||
hd
A ]

Hinh 3.11: Hop thoai Timing Chart.



3. Chon Device > Enter Device dé thém lénh

vao biéu do.

File [ Device ] Monitor
Enter Device F2
Delete Device Del
List Device Shift+F2
Property

4. Nhap tén Iénh can giam sat va thay doi trang théi tin hiéu , roi nhan Enter .

o
Er Device Entry

oS

— Dewvice

" Selection T Keylnput

% Nhap tén Iénh

o . 1

b Device Mumber

b . |2

— Dizplay Forrmat
W alue
|Dec =l
e
I'IE Bit Integer ;I
E niter I Cancel |
L -
Hinh 3.12: Hop thoai Device Entry
5. Dang biéu d6 Timing Chart .
ET Timing Chart ~— - R —— = -
File Device Monitor
Manitor Statu Device Entry Chart Display Range
¢ hio © Hand (r‘m r 0 v
0300 250 280 2P0 B0 80 40 W 220 -0 200 50 80 470 6D 450 40 A3 420 M0 00 40 B0 0 B0 BDO40 30 D I_D

i |
02 |
bl
bl | |
iy

024




Khi mudn 1énh nao 1&n ON , kich dup chuét vao Iénh d6 va nguoc lai .
Vi du : Kich dap chuét vao X006 , thi X006 chuyén thanh mau vang , va Ién mirc
ON.

ON ON ON ON

I I— I

OFF OFF OFF

3.15 Giao tiép véi PLC
Sau khi da kiém tra chuong trinh trén PLC 40 , ta S& nap chuong trinh vao PLC .
1. Chuyén PLC sang ché do Stop.
2. Cam cap USB-SC09 vao PLC va may tinh .
3. Kiém tra may tinh nhan cng Com bao nhiéu bang céch :
Budc 1. Kich chudt phai vao Computer rdi chon Manage .
Budc 2. Xuat hién hop thoai Computer Management, bam chon Device Manager,
sau do kich dup chuot vao Ports (COM & LPT).

-
A Computer Management

File Action View Help

== | > HE ==

;&- Computer Management (Local - a WING4BIT-PC
+ |} System Tools 339 Batteries
() Task Scheduler €) Bluetooth Radios
2] Event Viewer % Computer
22| Shared Folders ¢ = Disk drives
& Local Users and Groups B Display adapters
&) Performance g'ﬁ} Human Interface Devices
= Device Manager 4 IDE ATA/ATAPI controllers
| « % Storage 1 55 Imaging devices
| &=F Disk Management == Keyboards
_':‘-_, Services and Applications ):S Mice and other pointing devices
g Modems
B Monitors
&* Network adapters
4 |5 Other devices
U5 Bluetooth Peripheral Device
Y5 Ports (COM & LPT)
/ ¥ USB-SERIAL CH340 @
e— 2} Processors
% Sound, video and game controllers
1M System devices
@ Universal Serial Bus controllers

Nhu vay theo hinh trén , may tinh nhan COM 4.



4. M& phan mém GX Developer, tir thanh menu bam chon Onine > Transfer setup .
5. Xuat hién hop thoai Transfer Setup , kich dtp chudt vao Serial USB.

Transfer Setup

Other

station

- Te o g - [
B
Serial CC IE Cont HET(] CC-Link Ethemet PLC AF 55C
USE META0[H] board board board board board net
board Jj
COM |COM 5 Transmission speed |9.EKbps
FLC CCIE Cont MMETII) CC-Lirk Ethemet Cz4 G4 Bus
module META0[H] module module rmodule rodule
module Jd

Connection chanrnel list...

Mo zpecification Other station[Single network]  Other ztation[Co-existence network]

FLLC direct coupled setting

Time out [Sec.] |10 Retry times u} Connection test
M etwork | ‘ ‘ ’—_I
PLC type
C24 CC |E Cont MNETIII] CLC-Link. Ethernet
METAM0O[H)
Spztem  image...
| ‘ ‘ ‘ TEL [F=CPU)...
cz24 CCIE Cont  METII) CC-Link Ethermnet
MNETM0O[H] | K |
Acceszing host station |
Close

Hinh 3.16: Hop thoai Transfer Setup.
6. Xuat hién hop thoai bén dudi , chon céng COM rdi chon OK .

r

— )
Cancel

PC side /F Serial setting

= RS5-232C

[include Fx-USE-&h / F3U-LUSB-BD)
" USB[GOT transparent mode)

COM port

COk & -

Chon cong COM theo

Tranzmizzion speed | 9.6Kbps -

L

may tinh da nhan duoc




7. Bam vao Connection test dé kiém tra PLC d3 két voi may tinh thanh cong chua,
néu da két ndi thanh cong s& xuat hién hop thoai bén dudi .

\1.) Successfully connected with the FX1SCPU,

oK

8. Bam chon OK trong hop thoai Transfer Setup ,dé luu thiét lap va dong hop thoai .

-
}
9. Kich chon biéu tuong L‘ trén thanh céng cu , hoic trén thanh menu bam chon
Online > Write to PLC.

10. Xuét hién hop thoai Write to PLC

Write to PLC [
l Connecting interface |G>< Developer s |LLT
PLC Connection Station Mo, [Host  PLC type  [F=ZMNIC]
|F'LI: Fak /D evice mermony J |
Filz selection ] Device data ] Frogram ] Comrmon ] a >

Faram+Frog | Select all I Cancel all selections|
Cloze
V2

=l-#:] Program
E EIf‘~"|-"1"-”‘1 % Felated functions

EI@ Device comment
o g COMMBMEMNT

=-{sf] Parameter
. E FLC parameter

Remote operation. ..

Clear PLC memory...

Hinh 3.17: HOp thoai Write to PLC



11. Bam chon Select all, ri bam vao Execute s& xuat hién hop thoai bén duéi , chon
Yes dé chap nhan nap chuong trinh vao PLC.

MELSOFT series GX Developer =

! 5 Execute write to PLC?

Yes Q No
12. Trong thoi gian chuong trinh dwoc nap vao PLC , s& xuat hién hop thoai hién thi

tién do thuc hién .
Write to PLC

Wwiting, ,,
Frogram MAIN

475
EEEEEREEE
.

13. Bén khi xuét hién hop thoai bén dudi ,thi chwong trinh di nap vao PLC thanh cong
, bdm chon OK dé dong hop thoai .

MELSOFT series GX Developer E
\i.-l) Completed.

=]

14. Chuyén PLC sang ché d¢6 RUN .






